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Paper Set 1 · 13 Jun 2026 · 12:30 PM - 2:00 PM · OSSSC CRE 2025 (Odia)

Quant

✓

Q1 Quant
Pallavi, Ritu, and Vidya started a business with a capital in the ratio
3:5:8. At the end, they received a profit in the ratio 4:5:12. What is
the ratio of the time they invested?

A.  4:6:9​

B.  4:3:9​

C.  8:3:6

D.  8:6:9​

✓

Q2 Quant
ଜଣେ ବ୍ୟକ୍ତି  ₹34,000 ରେ ଏକ ୱାସିଂ  ମେସି ନ୍  କି ଣନ୍ତି  । ସେ ମରାମତି  ପାଇଁ  ₹6,000 ଖର୍ଚ୍ଚ
କରନ୍ତି  ଏବଂ ଏହାକୁ  15% ଲାଭରେ ଜଣେ ବନ୍ଧୁ କୁ  ବି କ୍ରି   କରନ୍ତି  । ବି କ୍ର ୟ ମୂ ଲ୍ୟ (₹ ରେ)
କେତେ?

A.  45,000

B.  45,500

C.  46,000

D.  46,500

✓

Q3 Quant
Water is flowing through a cylindrical pipe of radius 7 cm at a speed
of 5 m/s. How much water (in liters) flows through the pipe in 1
minute? (Use π = 22/7)

A.  3620

B.  4620

C.  3820

D.  4820

✓

Q4 Quant

Nupur invests ₹23664, which is 24% of her
monthly income, in mutual funds. What is
her monthly income?

A.  ₹98600

B.  ₹108600

C.  ₹86600

D.  ₹93600

✓

Q5 Quant
₹1,11,618 କୁ  ତି ନି  ଜଣ ପି ଲା C, D ଓ E ଙ୍କ ମଧ୍ୟରେ ବଣ୍ଟାଯାଇଛି , ଯାହା ଦ୍ଵାରା D ଓ E
ମି ଶି  ଯାହା ପାଆନ୍ତି  ତାହାର ପାଞ୍ଚ-ଅଷ୍ଟମାଂଶ C ପାଇପାରେ ଏବଂ C ଓ E ମି ଶି  ଯାହା ପାଆନ୍ତି
ତାହାର ଦୁ ଇ-ସପ୍ତମାଂଶ D ପାଇପାରେ । C ଓ E ଙ୍କ ଅଂଶ ମଧ୍ୟରେ ପାର୍ଥ କ୍ୟ କେତେ?

A.  ₹18,126

B.  ₹954

C.  ₹19,080

D.  ₹580

✓

Q6 Quant
Ajay is three times as efficient as Vijay. Working together, they
complete a task in 15 days. Find the number of days Ajay alone will
take to finish the task.

A.  12 days

B.  20 days

C.  30 days

D.  45 days

✓

Q7 Quant
If each observation in a dataset is multiplied by 3k (where k > 0),
then the weighted mean of the dataset will _________.

A.  remain unchanged

B.  be divided by 3k

C.  be multiplied by 3k

D.  be increased by 3k

✓

Q8 Quant
A train travels at a speed of 80 km/hr. How much time will it take to
cover a distance of 400 km?

A.  5 hours

B.  6 hours

C.  4 hours

D.  8 hours
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✓

Q9 Quant
ଦୁ ଇଟି  ସମାନ୍ତର ସରଳରେଖା PQ ଏବଂ RS ମଧ୍ୟରେ ଏକ ବି ନ୍ଦୁ  A ରୁ  AB ଓ AC ଦୁ ଇଟି
ସରଳରେଖା ଅଙ୍କନ କରାଯାଇଛି  ଯାହା PQ ଏବଂ RS କୁ  ଯଥାକ୍ର ମେ B ଓ C ବି ନ୍ଦୁ ରେ ଛେଦ
କରେ । ଯଦି  ∠QBA = 144° ଏବଂ ∠ACR = 28° ହୁ ଏ, ତେବେ ସୂ କ୍ଷ୍ମକୋଣ ∠BAC ର
ଡି ଗ୍ରୀ  ମାପ କେତେ?

A.  72°

B.  64°

C.  76°

D.  68°

✓

Q10 Quant
ଯଦି  ଗୋଟି ଏ ସଂଖ୍ୟାର 20% କୁ  30 ସହି ତ ଯୋଗ କରାଯାଏ, ତେବେ ଫଳାଫଳ ସମାନ
ସଂଖ୍ୟା ହେବ । ସମାନ ସଂଖ୍ୟାର 60% କେତେ?

A.  22.5

B.  7.5

C.  52.5

D.  42.5

✓

Q11 Quant
One pipe can fill a tank in 5 minutes, while another pipe can empty
the completely filled tank in 20 minutes. If both the pipes are
opened together when the tank is empty, how many minutes will it
take to fill three-fourths of the tank?

A.  5

B.  10

C.  6

D.  11

✓

Q12 Quant
₹5,376 ର ଏକ ମୂ ଳଧନକୁ  ତି ନି  ଭାଗରେ ବି ଭକ୍ତ କରାଯାଇଛି  ଯେପରି  ପ୍ର ଥମ ଭାଗର
ଅଧା, ଦ୍ୱି ତୀୟ ଭାଗର ଏକ ଚତୁ ର୍ଥାଂ ଶ ଏବଂ ତୃ ତୀୟ ଭାଗର ଏକ ଅଷ୍ଟମାଂଶ ସମାନ ହେବ ।
ପ୍ର ଥମ ଏବଂ ଦ୍ୱି ତୀୟ ଭାଗ ମଧ୍ୟରେ (₹ ରେ) ଧନାତ୍ମକ ଅନ୍ତର କେତେ ଅଟେ?

A.  768

B.  618

C.  718

D.  818

✓

Q13 Quant
ଏକ ଜି ନି ଷ ଉପରେ ଅର୍ଜିତ ଲାଭ 68% ଅଟେ । ଯଦି  କ୍ର ୟ ମୂ ଲ୍ୟ ଏବଂ ବି କ୍ର ୟ ମୂ ଲ୍ୟ
ଉଭୟର ସଂଖ୍ୟାଗୁ ଡ଼ି କୁ  ପରସ୍ପର ମଧ୍ୟରେ ଅଦଳବଦଳ କରାଯାଏ, ତେବେ ବି କ୍ର ୟରେ
ହୋଇଥି ବା କ୍ଷତି  ପ୍ର ତି ଶତ (ଦଶମି କ ଦୁ ଇ ସ୍ଥାନ ପର୍ଯ୍ୟ ନ୍ତ) କେତେ ହେବ?

A.  40.48%

B.  40.31%

C.  42.12%

D.  38.04%

✓

Q14 Quant

If ₹16,000 is invested at 5% per year for 2 years, what is the
difference between the compound interest (compounded annually)
and the simple interest?

A.  ₹40

B.  ₹46

C.  ₹34

D.  ₹48

✓

Q15 Quant
ବାର୍ଷିକ 10% ସୁ ଧ ହାରରେ 2 ବର୍ଷ ରେ କେତେ ମୂ ଳଧନ (₹ ରେ)ର ସରଳ ସୁ ଧ ₹600
ଦେବ?

A.  3000

B.  2500

C.  3200

D.  3400

✓

Q16 Quant

A quadratic equation ax2 + bx + c = 0 has two complex roots if:

A.  Discriminant = 0

B.  Discriminant < 0

C.  Discriminant > 0

D.  Discriminant ≤ 0
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✓

Q17 Quant
ମୋକ୍ଷି ଥଙ୍କୁ  ସହର A ରୁ  ସହର E ପର୍ଯ୍ୟ ନ୍ତ ଗ୍ରା ମ B, C ଓ D ଦେଇ ଯାତ୍ରା  କରି ବାକୁ  ପଡି ବ । A ରୁ  B ଓ C ରୁ  D ପର୍ଯ୍ୟ ନ୍ତ ଦୂ ରତା 150 km ଅଟେ, ଯାହାକୁ  ଅତି କ୍ର ମ କରି ବା ପାଇଁ  3 ଘଣ୍ଟା ସମୟ

ଲାଗି ଥାଏ । B ରୁ  C ଓ D ରୁ  E ପର୍ଯ୍ୟ ନ୍ତ ଦୂ ରତା x km ଦର୍ଶା ଯାଇଛି  ଏବଂ ଏଥି  ପାଇଁ  5 ଘଣ୍ଟା ସମୟ ଲାଗି ଥାଏ । ଯଦି  ହାରାହାରି  ବେଗ 60 km/hr ହୋଇଥାଏ, ତେବେ  ର ମୂ ଲ୍ୟ ନି ରୂ ପଣ

କର ।

A.  132

B.  145

C.  158

D.  172

✓

Q18 Quant

A.  3

B.  −3

C.  2

D.  −2

✓

Q19 Quant

A.  11.33

B.  15.95

C.  2.39

D.  8.97

✓

Q20 Quant

ଏକ ସରଳ ବୃ ତ୍ତଭୂ ମି କ କୋନ ଆକାର ଟେଣ୍ଟର ଆୟତନ 78,848 m3 ଅଟେ ଏବଂ ଏହାର ଭୂ ମି ର କ୍ଷେତ୍ର ଫଳ 2,464 m2 ଅଟେ । ଏହି  ଟେଣ୍ଟରେ 3 m × 2 m ମାପର ତି ନୋଟି  ଆୟତାକାର
ଝରକା ରହି ଛି  । ମନେକର ଟେଣ୍ଟଟି  କେବଳ ଆନତ ପାର୍ଶ୍ଵ  ପୃ ଷ୍ଠଗୁ ଡି କୁ  (ଚଟାଣ ନୁ ହେଁ ) ନେଇ ଗଠି ତ ଏବଂ ସି ଲେଇ ପାଇଁ  ନଷ୍ଟ ହେଉଥି ବା କପଡ଼ାକୁ  ଅଣଦେଖା କରି , ତମ୍ବୁ ତି ଆରି  ପାଇଁ  ଆବଶ୍ୟକ
ମୋଟ କପଡ଼ାର କ୍ଷେତ୍ର ଫଳ (m2 ରେ) ନି ର୍ଣ୍ଣ ୟ କର ।

(  ବ୍ୟବହାର କର । )

A.  9600

B.  8782

C.  9464

D.  8800
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GA

✓

Q21 GA
ଏଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଭାରତୀୟଙ୍କୁ  ସ୍ୱରାଜ ପାଇଁ  ପ୍ର ସ୍ତୁତ କରି ବା ନି ମନ୍ତେ
ଚରମପନ୍ଥୀମାନଙ୍କର ରଣନୀତି  ର ଅଂଶ ନଥି ଲା?

A.  ବ୍ରି  ଟି ଶ ସାମଗ୍ରୀ  ବର୍ଜ ନ କରି ବା

B.  ସ୍ଥାନୀୟ ବି ଦ୍ୟାଳୟଗୁ ଡ଼ି କୁ  ସଂଗଠି ତ କରି ବା

C.  ଅଦାଲତରେ ଆଇନଗତ ଲଢ଼େଇ  

D.  ସ୍ୱଦେଶୀ ଅନୁ ଷ୍ଠାନ ପ୍ର ତି ଷ୍ଠା 

✓

Q22 GA
Which department under the Government of India released the
policy document for DHRUVA?

A.  Department of Biotechnology

B.  Department of Commerce

C.  Department of Telecommunications

D.  Department of Posts

✓

Q23 GA
ଓଡ଼ି ଶାର ଦାବି  ଉପସ୍ଥାପନ କରି ବା ପାଇଁ  ମଧୁ ସୂ ଦନ ଦାସ କେଉଁ  ମସି ହାରେ ଇମ୍ପେରି ଆଲ
ଲେଜି ସଲେଟି ଭ କାଉନସି ଲର ସଭ୍ୟ ହୋଇଥି ଲେ?

A.  1907

B.  1910

C.  1913

D.  1916

✓

Q24 GA
ସେପ୍ଟେମ୍ବର 2025 ରେ ଆଦି ବାସୀ କଳାକୃ ତି ର ସଂରକ୍ଷଣ, ଶି କ୍ଷାର ପ୍ର ସାର ଏବଂ ଆଦି ବାସୀ
କାରି ଗରମାନଙ୍କୁ  ସଶକ୍ତ କରି ବା ଉଦ୍ଦେଶ୍ୟରେ 'ଆଦି ବାସୀ ବ୍ୟାପାର ମନ୍ତ୍ରାଳୟ' ଦ୍ୱାରା
ଶୁ ଭାରମ୍ଭ କରାଯାଇଥି ବା ଡି ଜି ଟାଲ୍  ପ୍ଲା ଟଫର୍ମ ର ନାମ କ’ଣ?

A.  ଆଦି  ସଂସ୍କୃତି  (Adi Sanskriti)

B.  ଭାରତ ସଂସ୍କୃତି  (Bharat Sanskriti)

C.  ପ୍ର ଥମ ସଂସ୍କୃତି  (Pratam Sanskriti)

D.  ଜୀବନ ସଂସ୍କୃତି  (Jivan Sanskriti)

✓

Q25 GA
ରାଜ୍ୟରେ ଯୋଜନାବଦ୍ଧ ସହରୀକରଣ ଏବଂ ସନ୍ତୁଳି ତ ଆଞ୍ଚଳି କ ବି କାଶକୁ  ପ୍ରୋ ତ୍ସାହି ତ କରି ବା
ପାଇଁ  2025 ମସି ହା ଜୁ ଲାଇ ମାସରେ ଓଡ଼ି ଶା ସରକାର ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ
ଯୋଜନାକୁ  ମଞ୍ଜୁ ର କରି ଥି ଲେ?

A.  ମୁ ଖ୍ୟମନ୍ତ୍ରୀ ସହର ବି କାଶ ଯୋଜନା

B.  ସୁ ସ୍ଥି ର ସହର ଯୋଜନା

C.  ସମୃ ଦ୍ଧ ସହର 

D.  ନବୀନ ଓଡ଼ି ଶା 

✓

Q26 GA
In graphite, each carbon atom is bonded to three other carbon
atoms forming a hexagonal arrangement. What type of bonding
exists between these carbon atoms?

A.  Ionic bond

B.  Covalent bond

C.  Metallic bond

D.  Hydrogen bond

✓

Q27 GA
Which city hosted the 2025 World Athletics Championships from 13–
21 September 2025?

A.  London

B.  Tokyo

C.  Doha

D.  Berlin

✓

Q28 GA
ଜୁ ଲାଇ 2025ରେ ଓଡ଼ି ଶାରେ ଘୋଷଣା କରାଯାଇଥି ବା “ସବୁ ଜ ଜୀବି କା” (Green
livelihoods) ପଦକ୍ଷେପ ଅଧୀନରେ, ନୂ ତନ “ସବୁ ଜ ଜୀବି କା” ର ଲକ୍ଷ୍ୟ ସଂଖ୍ୟା କେତେ
ଅଟେ?

A.  5 ଲକ୍ଷ

B.  8 ଲକ୍ଷ

C.  10 ଲକ୍ଷ

D.  12 ଲକ୍ଷ

✓

Q29 GA
ଓଡ଼ି ଶାରେ ଅନୁ ଭୂ ତ ହେଉଥି ବା ପ୍ର ବଳ ବର୍ଷା  ପାଇଁ  ମୁ ଖ୍ୟତଃ କେଉଁ  ମୌସୁ ମୀ ବାୟୁ  ଦାୟୀ
ଅଟେ?

A.  ପଶ୍ଚି ମା ଝଡ଼

B.  ଉତ୍ତର-ପୂ ର୍ବ  ମୌସୁ ମୀ

C.  ଦକ୍ଷି ଣ-ପଶ୍ଚି ମ ମୌସୁ ମୀ

D.  ପ୍ର ତ୍ୟାବର୍ତ୍ତୀ  ମୌସୁ ମୀ

✓

Q30 GA
2025 ମସି ହାରେ, ଉତ୍ତରପାଡା (Uttarpara) ରେ 395 ଏକର ଜମି  ପୁ ନଃପ୍ରା ପ୍ତ କରି ବା
ପାଇଁ  ପଶ୍ଚି ମବଙ୍ଗ ସରକାରଙ୍କ ନି ଷ୍ପତ୍ତି କୁ  ସମର୍ଥ ନ କରି  ସୁ ପ୍ରି  ମକୋର୍ଟ  କେଉଁ  କମ୍ପାନୀର
ଆବେଦନକୁ  ଖାରଜ କରି ଥି ଲେ?

A.  ଅଶୋକ ଲେଲାଣ୍ଡ

B.  ହି ନ୍ଦୁ ସ୍ତାନ ମୋଟର୍ସ

C.  ମାରୁ ତି  ସୁ ଜୁ କି

D.  ଟାଟା ମୋଟର୍ସ
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✓

Q31 GA
Which Article of the Constitution of India guarantees the Right to
Constitutional Remedies by allowing citizens to approach the
Supreme Court for enforcement of Fundamental Rights?

A.  Article 21

B.  Article 19

C.  Article 32

D.  Article 25

✓

Q32 GA
Which major geographical characteristic makes Nepal reliant on
India for global connectivity and transit?

A.  The sharing of a common cultural and religious history

B.  Being a landlocked country bordered by India and China

C.  The presence of the high Himalayan mountain ranges

D.  Its location within the fertile Indo-Gangetic plain region

✓

Q33 GA
Which of the following pairs of eminent Indian dancers and their
associated classical dance traditions is correctly matched?

A.  Guru Bipin Singh - Kathakali

B.  Kelucharan Mohapatra - Kathak

C.  Birju Maharaj - Odissi

D.  Rukmini Devi Arundale - Bharatanatyam

✓

Q34 GA
ଏକ ତାରରେ ଏକ ସ୍ଥି ର ବି ଦ୍ୟୁ ତ ସ୍ରୋ ତ I ପ୍ର ବାହି ତ ହେଉଛି  । ଯଦି  ପ୍ର ୟୋଗ କରାଯାଇଥି ବା
ଭୋଲଟେଜକୁ  ଅପରି ବର୍ତ୍ତିତ ରଖି  ତାରର ପ୍ର ତି ରୋଧକୁ  ହଠାତ ଦୁ ଇଗୁ ଣ କରାଯାଏ,
ତେବେ ପାୱାର କ୍ଷୟ (power dissipated) ଉପରେ କି  ପ୍ର ଭାବ ପଡ଼ି ଥାଏ?

A.  ପାୱାର କ୍ଷୟ ଅପରି ବର୍ତ୍ତିତ ରହେ 

B.  ପାୱାର କ୍ଷୟ ପ୍ରା ରମ୍ଭି କ ମୂ ଲ୍ୟର ଚାରି  ଗୁ ଣ ହୋଇଯାଏ

C.  ପାୱାର କ୍ଷୟ ପ୍ରା ରମ୍ଭି କ ମୂ ଲ୍ୟର ଅଧା ହୋଇଯାଏ 

D.  ପାୱାର କ୍ଷୟ ଦୁ ଇଗୁ ଣ ହୁ ଏ 

✓

Q35 GA
ଧାରଣୀୟ ବି କାଶର କେଉଁ  ନୀତି ଟି  ଭବି ଷ୍ୟତ ପି ଢ଼ି ଙ୍କୁ  କ୍ଷତି  ନ ପହଞ୍ଚାଇ, ବର୍ତ୍ତ ମାନର
ଆବଶ୍ୟକତା ପୂ ରଣ କରି ବା ଉପରେ ମୁ ଖ୍ୟତଃ ଧ୍ୟାନ ଦେଇଥାଏ?

A.  ଆର୍ଥିକ ବଳକା (Economic surplus)

B.  ଆନ୍ତଃପି ଢ଼ି  ସମତା (Intergenerational equity)

C.  ଶି ଳ୍ପ ସମ୍ପ୍ରସାରଣ (Industrial expansion)

D.  ସମ୍ବଳର ଅତ୍ୟଧି କ ବ୍ୟବହାର (Resource exploitation)

✓

Q36 GA
Which tribal dance is performed in parts of Jharkhand and Odisha
and often uses masks?

A.  Chhau

B.  Garba

C.  Bhangra

D.  Lavani

✓

Q37 GA
To the northwest of the Aravali hills lies which geographic feature?

A.  The Peninsular Plateau

B.  The Great Indian Desert

C.  The Deccan Plateau

D.  The Himalayan Foothills

✓

Q38 GA
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ ଟି  ଭାରତରେ କୃ ଷି  ବି ବି ଧତାକୁ  ପ୍ର ତି ଫଳି ତ କରେ?

A.  ଗହମ ଏବଂ ଚାଉଳ ଭଳି  କେବଳ ପାରମ୍ପରି କ ଖାଦ୍ୟ ଫସଲ ଚାଷ କରି ବା

B.  ପଶୁ ପାଳନ, ମତ୍ସ୍ୟପାଳନ ଏବଂ ଉଦ୍ୟାନ କୃ ଷି  ଭଳି  ଆନୁ ସଙ୍ଗି କ କାର୍ଯ୍ୟ କଳାପରେ
ବି ସ୍ତାର କରି ବା

C.  ମୌସୁ ମୀ ଭି ତ୍ତି କ ଫସଲ ଉତ୍ପାଦନ ପ୍ର ଣାଳୀ ଉପରେ ନି ର୍ଭ ରଶୀଳତା ବୃ ଦ୍ଧି  କରି ବା

D.  ପ୍ର ମୁ ଖ ଶସ୍ୟ ଫସଲରେ ଯାନ୍ତ୍ରି କ କୃ ଷି  ପ୍ର ଣାଳୀକୁ  ପ୍ରୋ ତ୍ସାହି ତ କରି ବା

✓

Q39 GA
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ ଟି  ପ୍ରା କୃ ତି କ ପରି ସଂସ୍ଥାର ଏକ ଉଦାହରଣ ନୁ ହେଁ ?

A.  ଜଙ୍ଗଲ

B.  ହ୍ର ଦ

C.  ନଦୀ

D.  ଚାଷ ଜମି

✓

Q40 GA
ଜାତୀୟ ମହାସାଗରୀୟ ଏବଂ ବାୟୁ ମଣ୍ଡଳୀୟ ପ୍ର ଶାସନ (NOAA) ଅନ୍ତର୍ଗ ତ ପରି ବେଶ ସୂ ଚନା
ନି ମନ୍ତେ ଜାତୀୟ କେନ୍ଦ୍ରର ବାର୍ଷିକ ରି ପୋର୍ଟ  ଅନୁ ଯାୟୀ 1850 ମସି ହାରେ ବି ଶ୍ୱସ୍ତରୀୟ
ରେକର୍ଡ  ଆରମ୍ଭ ହେବା ପରଠାରୁ  କେଉଁ  ବର୍ଷ ଟି  ସର୍ବା ଧି କ ଉଷ୍ମ  ବର୍ଷ  ଥି ଲା?

A.  2019

B.  2020

C.  2022

D.  2024
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English

✓

Q41 English
Read the following options carefully and choose the one that is not correctly written in indirect speech.

A.  Rohan said that I am learning the guitar.

B.  Tanvi asked where the surf competition was held.

C.  Arjun said that he would climb the mountain the next day.

D.  They reported that the campfire had gone out.

✓

Q42 English
Select the most appropriate proverb to substitute the highlighted segment in the given sentence.

The child asked a deep question, proving that people who seem quiet often think deeply.

A.  the squeaky wheel gets the grease

B.  actions speak louder than words

C.  still waters run deep

D.  curiosity killed the cat

✓

Q43 English
Select the most appropriate option to fill in the blank.

This time next week, I ______________ my vacation in the hills.

A.  have enjoyed

B.  enjoyed

C.  will be enjoying

D.  had enjoyed

✓

Q44 English
Choose the correct active sentence of the given passive sentence from the following options.
The championship trophy was proudly lifted by the team after winning the intense football match.

A.  The team proudly lifted the championship trophy after winning the intense football match.

B.  The team was proudly lifting the championship trophy after winning the intense football match.

C.  The team has proudly lifted the championship trophy after winning the intense football match.

D.  The team had proudly lifted the championship trophy after winning the intense football match.

✓

Q45 English
Choose the proverb that best replaces the highlighted segment.

After losing his high-paying job, the individual was devastated; however, he used his free time to start a small business that eventually became
a massive success, proving that every difficult or negative situation has a positive aspect to it.

A.  still waters run deep

B.  every cloud has a silver lining

C.  every dog has his day

D.  a rolling stone gathers no moss
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✓

Q46 English
Select the most suitable option to complete the sentence.
The scientist's ______ approach to the experiment led to a surprising and successful discovery.

A.  cautious

B.  innovative

C.  predictable

D.  reluctant

✓

Q47 English
Choose the correct antonym of the underlined word in the given sentence.

The instructions were explicit, leaving no room for confusion among the participants.

A.  precise

B.  formal

C.  vague

D.  practical

✓

Q48 English
Choose the correct antonym of the underlined word in the given sentence.

The actor was generous when it came to donating money for humanitarian causes.

A.  charitable

B.  persuasive

C.  stingy

D.  liberal

✓

Q49 English

Read the passage carefully and answer the questions that follow.

The city’s roadsides in summers are often seen with colourful bottles of sharbat syrups lined up, while vendors are offering glasses of sharbat to
thirsty customers. Several years ago, people in the Middle East introduced the sharbat drink to keep themselves cool and hydrated in the hot and
humid weather. This tasty drink was originally made with rose petals and a mix of fruits like oranges and mangoes, etc, along with chia seeds as
a main ingredient. The drink has travelled across regions and with the movement of trade, sharbat slowly finds a place in India. Earlier, people
made sharbat syrup by themselves by soaking roots of the nannari plant for hours, and it was strained, then the mix was boiled along with a
lemon slice and palm sugar or jaggery. After extracting the syrup, they made the drink, which was then stored in mud pots to keep it cool.

Choose the most appropriate title for the passage.

A.  The Origin and Journey of Sharbat as a Refreshing Drink

B.  The Importance of Summer Beverages in Indian Cities

C.  The Process of Making Traditional Syrups at Home

D.  The Role of Trade in Spreading Food Cultures

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q50 English
Which of the following is a fact stated in the passage?

A.  Sharbat was first introduced in India by modern vendors.

B.  The drink originally included rose petals and fruits.

C.  The syrup was always prepared using artificial flavours.

D.  The drink was stored in metal containers to stay cool.

✓

Q51 English
Why was sharbat introduced in the Middle East?

A.  To promote trade between different regions and cultures

B.  To provide a cooling and hydrating drink in hot weather

C.  To preserve fruits for consumption during colder seasons

D.  To replace other beverages that were less popular

✓

Q52 English
Which of the following best summarises the passage?

A.  A detailed description of modern drinks sold in markets

B.  An explanation of sharbat’s origin, spread, and preparation

C.  A comparison of traditional and modern cooling beverages

D.  A discussion on the health benefits of drinking sharbat

✓

Q53 English
What is the tone of the passage?

A.  Critical of traditional food practices

B.  Emotional about childhood experiences

C.  Encouraging people to buy sharbat daily

D.  Informative about cultural beverage history

✓

Q54 English
Instruction: The first segment of the statement is fixed. Arrange the remaining segments (A–D) to form a coherent and meaningful statement.
Fixed Part – A reliable monitoring system helps organisations maintain security —by continuously observing activities (A) / across different
departments carefully (B) / and identifying unusual patterns quickly (C) / to prevent potential risks effectively (D) /

A.  A – B – C – D

B.  B – C – D – A

C.  A – C – D – B

D.  D – A – B – C

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q55 English
Complete the sentence by choosing the correct option.
My father usually returns from work ................ sunset.

A.  at

B.  in

C.  on

D.  between

✓

Q56 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

A. championship, and their
B. when they won the
C. cheers of joy echoed
D. the team was ecstatic
E. throughout the stadium

A.  EABDC

B.  DBACE

C.  BACED

D.  ACBDE

✓

Q57 English
Select the option that can be used as a one-word substitute for the given group of words.

A person who travels to unknown places to find new lands

A.  Explorer

B.  Tourist

C.  Merchant

D.  Pilgrim

✓

Q58 English
Select the option that can be used as a one-word substitute for the given phrase.

Payment or compensation for work and services

A.  Allowance

B.  Charity

C.  Remuneration

D.  Reimbursement
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✓

Q59 English
Select the option to correct the spelling error in the sentence.

She had to definately cancel her plans due to the storm.

A.  definatly

B.  definately

C.  definitley

D.  definitely

✓

Q60 English
Select the most appropriate option to fill in the blank.

He ate _______ apple before leaving for school.

A.  an

B.  a

C.  the

D.  this

Odia

✓

Q61 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ଭି ନ୍ନ ପ୍ର କାରର ଅନେକ ସାମୁ ଦ୍ରି  କ ଜୀବଜନ୍ତୁ ବି ଶ୍ୱସାରା ମହାସାଗର ଏବଂ ସମୁ ଦ୍ର ଗୁ ଡି କରେ ରହନ୍ତି  ।

A.  Many different types of marine creatures live in oceans and seas all over the world.

B.  Many different types of marine creatures lives in oceans and seas all over world.

C.  Many different type of marine creatures live in oceans and seas all over world.

D.  Many different types of marine creature living in oceans and seas over the world.

✓

Q62 Odia
"ଦି ଆଯାଇଥି ବା ବାକ୍ୟର ସଠି କ୍  ଓଡ଼ି ଆ ଅନୁ ବାଦ କେଉଁ ଟି ?
Education shapes the character of a person.

A.  ବ୍ୟକ୍ତି ର ଚରି ତ୍ର  ଗଠନରେ ଶି କ୍ଷା ସହାୟକ ହୁ ଏ।

B.  ଶି କ୍ଷା ଏକ ମଣି ଷର ଜୀବନକୁ  ଭଞ୍ଜେ।

C.  ଶି କ୍ଷା ଏକ ମଣି ଷର ସ୍ଵପ୍ନ କୁ  ଭାଙ୍ଗେ।

D.  ଶି କ୍ଷା ଏକ ମଣି ଷର ଧନକୁ  ବଢ଼ାଏ।

✓

Q63 Odia
‘କୁ ଞ୍ଚୁ କୁ ଞ୍ଚୁ ଆ ମାଗୁ ର ନି ଶୁ ଆ, ହି ଆରେ ନ ଥାଏ ବାଳ, ଏ ତି ନି ଙ୍କୁ  ପରତେ ନ ଯି ବ ବଂଚି ଥି ବ ଯେତେକାଳ’ ର ଅର୍ଥ  କ’ଣ?

A.  ଭୟ କି ମ୍ବା ଦୃ ଷ୍ଟି ଭଙ୍ଗୀ ସୂ ଚନା

B.  ଚତୁ ର, ଚାଳାକ ମାତ୍ର  ଅସାଧୁ  ଲୋକ ତି ଷ୍ଠି  ଯାଆନ୍ତି

C.  ଚତୁ ର, ଚାଳାକ ଲୋକ ସଦା ଅସୁ ବି ଧାରୁ  ବାହାରି  ଆସନ୍ତି

D.  ଅକାରଣ ଭୟଭୀତ ଲୋକ
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✓

Q64 Odia
ସଠି କ ତଦ୍ଭବ ଶବ୍ଦ ବାଛନ୍ତୁ: “ଶି ଶୁ ” ର ତଦ୍ଭବ କଣ?

A.  ପି ଲା

B.  ଛୁ ଆ

C.  ବାଳକ

D.  ପି ଲାଟି ଆ

✓

Q65 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ଦ୍ଵାରକା ରେ ବହୁ ତ ପ୍ରା ଚୀନ ମନ୍ଦି ର ରହି ଛି  ।

A.  There are many ancient temples in Dwarka.

B.  There were many ancient temples in Dwarka.

C.  There are many temples in Dwarka.

D.  There are very beautiful temples in Dwarka.

✓

Q66 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦର ବି ଷୟବସ୍ତୁକୁ  ଭଲଭାବରେ ପଢ । ତା ତଳେ ପ୍ର ଦତ୍ତ ପ୍ର ତ୍ୟେକ ପ୍ର ଶ୍ନ ର ଚାରି ଟି  ସମ୍ଭାବି ତ ଉତ୍ତର ମଧ୍ୟରୁ  ସଠି କ ଉତ୍ତରକୁ  ଚୟନ କରନ୍ତୁ|

ଦି ଲ୍ଲୀ-ଏନସି ଆର ଅଞ୍ଚଳରେ ବାୟୁ  ପ୍ର ଦୂ ଷଣ ମୁ କାବି ଲା ଆଧୁ ନି କ ଭାରତରେ ସବୁ ଠାରୁ  ଚ୍ୟାଲେଞ୍ଜପୂ ର୍ଣ୍ଣ  ପରି ବେଶଗତ କାର୍ଯ୍ୟ  ମଧ୍ୟରୁ  ଗୋଟି ଏ ହୋଇଯାଇଛି  । ଦି ଲ୍ଲୀର ଦ୍ରୁ ତ ସହରୀକରଣ, ବର୍ଦ୍ଧିତ
ଜନସଂଖ୍ୟା ଏବଂ ବି ସ୍ତାରି ତ ଶି ଳ୍ପ କାର୍ଯ୍ୟ କଳାପ ଏହାର ବାୟୁ  ଗୁ ଣବତ୍ତା ଉପରେ ଅତ୍ୟଧି କ ଚାପ ପକାଇଛି । ଶୀତ ମାସରେ, ଘନ କୁ ହୁ ଡ଼ି  ପ୍ରା ୟତଃ ସହରକୁ  ଘୋଡ଼ାଇ ରଖେ, ଦୃ ଶ୍ୟମାନତା ହ୍ରା ସ କରେ
ଏବଂ ଗମ୍ଭୀର ସ୍ୱାସ୍ଥ୍ୟ ବି ପଦ ସୃ ଷ୍ଟି  କରେ । ଏହି  ସମସ୍ୟା କେବଳ ଦି ଲ୍ଲୀରେ ସୀମି ତ ନୁ ହେଁ ; ବରଂ ଗୁ ରୁ ଗ୍ରା ମ, ନୋଏଡା, ଗାଜି ଆବାଦ ଏବଂ ଫରି ଦାବାଦ ଭଳି  ପଡ଼ୋଶୀ ଅଞ୍ଚଳ ଗୁ ଡ଼ି କ ଉପରେ ମଧ୍ୟ
ଗମ୍ଭୀର ପ୍ର ଦୂ ଷଣ ର ପ୍ର ଭାବ ପଡି ଥାଏ ଓ ଏହାକୁ  ଏକ ଆଞ୍ଚଳି କ ସଙ୍କଟରେ ପରି ଣତ କରି ଥାଏ।

ଦି ଲ୍ଲୀର ପ୍ର ଦୂ ଷଣର ଏକ ପ୍ର ମୁ ଖ କାରଣ ହେଉଛି  ଯାନବାହାନ ନି ର୍ଗ ମନ। ରାସ୍ତାରେ ଲକ୍ଷ ଲକ୍ଷ ଯାନବାହାନ ସହି ତ, କାର, ବସ୍  ଏବଂ ଟ୍ର କରୁ  ନି ର୍ଗ ତ ପଦାର୍ଥ  ବାୟୁ ରେ କ୍ଷତି କାରକ କଣି କାକୁ  ଯଥେଷ୍ଟ ବୃ ଦ୍ଧି
କରେ। ଶି ଳ୍ପ କାର୍ଯ୍ୟ କଳାପ, ନି ର୍ମା ଣ ଧୂ ଳି  ଏବଂ ଅନୁ ପଯୁ କ୍ତ ଅଳି ଆ ପୋଡ଼ି  ପରି ସ୍ଥି ତି କୁ  ଆହୁ ରି  ଖରାପ କରି ଥାଏ। ପଞ୍ଜାବ ଏବଂ ହରି ୟାଣା ଭଳି  ପଡ଼ୋଶୀ ରାଜ୍ୟ ଗୁ ଡ଼ି କରେ ଚାଷୀଙ୍କ ଦ୍ୱାରା ଋତୁ କାଳୀନ
ନଡ଼ା ଜାଳି ବା ଦ୍ଵାରା ବାୟୁ ମଣ୍ଡଳରେ ଧୂ ଆଁ ର ଏକ ବି ପୁ ଳ ପରି ମାଣ ବୃ ଦ୍ଧି  କରେ, ଯାହା ପ୍ର ଦୂ ଷଣର ମାତ୍ରା  ଆହୁ ରି  ବୃ ଦ୍ଧି  କରି ଥାଏ ।

ସରକାର, ନ୍ୟାୟପାଳି କା ଏବଂ ପରି ବେଶଗତ ଏଜେନ୍ସି  ଗୁ ଡ଼ି କ ପ୍ର ଦୂ ଷଣ ନି ୟନ୍ତ୍ରଣ ପାଇଁ  ଅନେକ ପଦକ୍ଷେପ ନେଇଛନ୍ତି  । ଏଥି ରେ ବୈ ଦ୍ୟୁ ତି କ ଯାନବାହନକୁ  ପ୍ରୋ ତ୍ସାହି ତ କରି ବା, ସର୍ବା ଧି କ ପ୍ର ଦୂ ଷଣ
ସମୟରେ ଅଡ୍ -ଇଭେନ୍  ଟ୍ରା ଫି କ୍  ଯୋଜନା ଲାଗୁ  କରି ବା ଏବଂ ସ୍ମଗ୍  ଟାୱାର ସ୍ଥାପନ କରି ବା ଅନ୍ତର୍ଭୁ କ୍ତ । ଏହା ସହି ତ, ପ୍ର ଦୂ ଷଣ ସ୍ତରକୁ  ଟ୍ରା କ୍  କରି ବା ପାଇଁ  ପ୍ର କୃ ତ-ସମୟ ବାୟୁ  ଗୁ ଣବତ୍ତା ମନି ଟରିଂ
ସି ଷ୍ଟମ ସ୍ଥାପନ କରାଯାଇଛି  । ଜନସଚେତନତା ଅଭି ଯାନରେ ନାଗରି କମାନଙ୍କୁ  ଅଳି ଆ ପୋଡ଼ି ବାରୁ  ବାରଣ କରି ବା , କାର-ପୁ ଲ କରି ବା ଏବଂ ଅଧି କ ଗଛ ଲଗାଇବା ପାଇଁ  ଉତ୍ସାହି ତ କରାଯାଉଛି  । ଏହି
ପ୍ର ୟାସ ସତ୍ତ୍ୱେ, ଅନେକ ଅଂଶୀଦାର ଏବଂ ପାଗ ପରି ସ୍ଥି ତି  ଯୋଗୁଁ  ପ୍ର ଦୂ ଷଣ ନି ୟନ୍ତ୍ରଣ ଏକ ଜଟି ଳ ସମସ୍ୟା ହୋଇ ରହି ଛି  ।

ବାୟୁ  ପ୍ର ଦୂ ଷଣ ଲକ୍ଷ ଲକ୍ଷ ଲୋକଙ୍କ ସ୍ୱାସ୍ଥ୍ୟକୁ  ପ୍ର ଭାବି ତ କରୁ ଛି , ଯାହା ଶ୍ୱାସକ୍ରି  ୟା ସମସ୍ୟା, ଆଖି  ଜ୍ୱଳନ ଏବଂ ଆସ୍ଥମା ଏବଂ ଫୁ ସଫୁ ସ କ୍ଷତି  ଭଳି  ଦୀର୍ଘ କାଳୀନ ରୋଗର କାରଣ ପାଲଟି ଛି  । ଗୁ ରୁ ତର
ପ୍ର ଦୂ ଷଣ ଘଟଣା ସମୟରେ ସ୍କୁଲଗୁ ଡ଼ି କ କେତେକ ସମୟରେ ବନ୍ଦ ହୋଇଯାଏ ଏବଂ ବୟସ୍କ ନାଗରି କ ମାନଙ୍କୁ  ଘର ଭି ତରେ ରହି ବାକୁ  ପରାମର୍ଶ  ଦି ଆଯାଏ। ବି ଶେଷଜ୍ଞମାନଙ୍କ କହି ବାନୁ ଯାୟୀ କେବଳ
ସାମୂ ହି କ କାର୍ଯ୍ୟ  , ସରକାରୀ ନୀତି , ଜନ ସହଯୋଗ, ପ୍ର ଯୁ କ୍ତି ବି ଦ୍ୟା ନବସୃ ଜନ ଏବଂ ସ୍ଥାୟୀ ଅଭ୍ୟାସ ହିଁ ଦୀର୍ଘ କାଳୀନ ଉନ୍ନତି  ଆଣି ପାରି ବ। ଦି ଲ୍ଲୀ-ଏନସି ଆରରେ ବାୟୁ  ପ୍ର ଦୂ ଷଣର ମୁ କାବି ଲା କରି ବା
କେବଳ ଏକ ପରି ବେଶଗତ ଚ୍ୟାଲେଞ୍ଜ ନୁ ହେଁ  ବରଂ ଜନସ୍ୱାସ୍ଥ୍ୟ ଏବଂ ଏକ ଉତ୍ତମ ଭବି ଷ୍ୟତ ସୁ ନି ଶ୍ଚି ତ କରି ବା ପାଇଁ  ଏକ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ପଦକ୍ଷେପ।

" ଚ୍ୟାଲେଞ୍ଜପୂ ର୍ଣ୍ଣ  " ଶବ୍ଦର ଅର୍ଥ  କଣ ?

A.  ସହଜ

B.  କଷ୍ଟକର

C.  ଗୁ ରୁ ତ୍ୱହୀନ

D.  ଶୀଘ୍ର
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✓

Q67 Odia
ଦି ଲ୍ଲୀର ପ୍ର ଦୂ ଷଣର ଏକ ପ୍ର ମୁ ଖ କାରଣ ହେଉଛି  ________ ।

A.  ପାଣି ର ଅଭାବ

B.  ଯାନବାହନ ନି ର୍ଗ ମନ

C.  ପାହାଡି ଆ ପବନ

D.  ମାଛ ଧରି ବା କାର୍ଯ୍ୟ କଳାପ

✓

Q68 Odia
ଜନସଚେତନତା ଅଭି ଯାନରେ ନାଗରି କ ମାନଙ୍କୁ  ବି ଶେଷକରି  କେଉଁ  କାର୍ଯ୍ୟ  ରୁ  ବାରଣ କରାଯାଉଛି ?

A.  ଅଳି ଆ ପୋଡ଼ି ବା

B.  ଗଛ ଲଗାଇବା

C.  କାର ପୁ ଲ କରି ବା

D.  ବି ଦ୍ୟୁ ତ ଯାନ ଚାଳନା କରି ବା

✓

Q69 Odia
କେଉଁ  ଅଭ୍ୟାସ ଋତୁ କାଳୀନ ପ୍ର ଦୂ ଷଣ ବୃ ଦ୍ଧି ରେ ସହାୟକ ହୁ ଏ?

A.  ନଡ଼ା ଜାଳି ବା

B.  ବର୍ଷା

C.  ସୌରଶକ୍ତି

D.  ନଦୀ ସଫେଇ

✓

Q70 Odia
ସାମୂ ହି କ କାର୍ଯ୍ୟ  ଅର୍ଥ  କଣ?

A.  ଜଣେ ବ୍ୟକ୍ତି ଙ୍କ ପ୍ର ୟାସ

B.  ଅନେକଙ୍କ ମି ଳି ତ ପ୍ର ୟାସ

C.  ଅନି ୟମି ତ କାର୍ଯ୍ୟ

D.  କେବଳ ବ୍ୟକ୍ତି ଗତ ନି ଷ୍ପତ୍ତି

✓

Q71 Odia
ଏତେ ଔଷଧ ଖାଇଲି  ତଥାପି  ଦେହ ଭଲ ହେଉନି  - ରେଖାଙ୍କି ତ ପଦଟି  କେଉଁ  ଅବ୍ୟୟ ?

A.  ସଂଯୋଜକ ଅବ୍ୟୟ

B.  ବି ଯୋଜକ ଅବ୍ୟୟ

C.  ବି ସ୍ମୟସୂ ଚକ ଅବ୍ୟୟ

D.  ବି କଳ୍ପାର୍ଥ କ ଅବ୍ୟୟ

✓

Q72 Odia
"ନାଟର ଗୋବର୍ଦ୍ଧ ନ" ଏହି  ରୂ ଢି ର ଅର୍ଥ  ଲେଖ ।

A.  ଅନର୍ଥ ର ମୂ ଳ

B.  ଅପବ୍ୟୟ କରି ବା

C.  ଅତି ଦୁ ଷ୍ଟ

D.  ଅତି  ବି ଶ୍ଵାସ
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✓

Q73 Odia
ଥରକୁ  ଥର ଏମି ତି  ଭୁ ଲ୍  କଲେ ଦଣ୍ଡି ତ ହେବ । ଉକ୍ତ ବାକ୍ୟରେ ଅବ୍ୟୟ ପଦଟି  ଚି ହ୍ନଟ କର ।

A.  ଥରକୁ  ଥର

B.  ଭୁ ଲ୍

C.  ଏମି ତି

D.  ଦଣ୍ଡି ତ ହେବା

✓

Q74 Odia
ଗୋବି ନ୍ଦ ଜଣେ ଉତ୍ତମ ନେତା,ସୁ ତରାଂ ଭଲ ଶାସନ ଦେବେ । - ଏଠାରେ ଅବ୍ୟୟ ପଦଟି  ଚି ହ୍ନଟ କର ।

A.  ଗୋବି ନ୍ଦ

B.  ଭଲ ନେତା

C.  ସୁ ତରାଂ

D.  ଶାସନ ଦେବେ

✓

Q75 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  ତତ୍ସମ ଶଦ୍ଦ କେଉଁ ଟି  ?

A.  ମୃ ତ୍ତି କା

B.  ଧୋତି

C.  ସି ଧା

D.  ହାକୁ ଟି

Computer

✓

Q76 Computer
In modern offices, computers are widely used for managing tasks
like writing letters, preparing financial reports, and sending emails
to clients. This use of computers primarily falls under which
application category?

A.  Entertainment and Gaming

B.  Industrial Automation

C.  Scientific Research

D.  Business and Commerce

✓

Q77 Computer
A student is managing a large MS PowerPoint 2021 presentation.
Which statement is True or False?
(i) When a new slide is inserted using the 'New Slide' button, it is
placed before the selected slide.
(ii) To select and delete non-adjacent slides, hold the Ctrl key, click
the slides, and press Delete.

A.  (i) True, (ii) True

B.  (i) True, (ii) False

C.  (i) False, (ii) True

D.  (i) False, (ii) False

✓

Q78 Computer
Which option in PowerPoint allows you to change the existing
design template of a presentation?

A.  File → Save As

B.  Design → Themes

C.  Insert → Template

D.  View → Slide Sorter

✓

Q79 Computer
To set a slide to advance automatically after 5 seconds during a
show (without clicking), you should:

A.  Transitions tab → Timing group → After: 00:05.00

B.  Slide Show → Use Timings checkbox only

C.  File → Options → Set Slide Time

D.  View → Slide Sorter → Delay
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✓

Q80 Computer
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ୱାଇଡ ଏରି ଆ ନେଟୱାର୍କ  (WAN) କୁ  ସର୍ବୋ ତ୍ତମ ଭାବରେ
ବର୍ଣ୍ଣ ନା କରେ?

A.  ଏକ ନେଟୱାର୍କ  ଯାହା ଗୋଟି ଏ ବି ଲଡି ଙ୍ଗ କି ମ୍ବା କ୍ୟାମ୍ପସ ପର୍ଯ୍ୟ ନ୍ତ ସୀମି ତ ଥାଏ ।

B.  ବୃ ହତ ଜି ୟୋଗ୍ରା ଫି କାଲ ଅଞ୍ଚଳରେ କମ୍ପ୍ୟୁ ଟର ଏବଂ LAN କୁ  ସଂଯୋଗ କରୁ ଥି ବା
ଏକ ନେଟୱାର୍କ

C.  କେବଳ ଏକ କୋଠରୀ ମଧ୍ୟରେ ୱାରଲେସ କନେକ୍ସନ ପାଇଁ  ବ୍ୟବହୃ ତ ଏକ
ନେଟୱାର୍କ

D.  କେବଳ ପ୍ରି  ଣ୍ଟର ଏବଂ ସ୍କାନର ପାଇଁ  ବ୍ୟବହୃ ତ ଏକ ପ୍ରା ଇଭେଟ ନେଟୱାର୍କ

✓

Q81 Computer
MS ଏକ୍ସେଲରେ ଏକାଧି କ କଲମକୁ  ସର୍ଟ  (Sort) କରି ବା ପାଇଁ  କେଉଁ  ପ୍ର କାରର ସର୍ଟି
ସବୁ ଠାରୁ  ଉପଯୁ କ୍ତ ଅଟେ?

A.  Ascending Order

B.  Descending Order

C.  Custom Sort

D.  Color Sort

✓

Q82 Computer
ଆବାକସକୁ  ହି ସାବ କରି ବା ପାଇଁ  ବ୍ୟବହୃ ତ ପ୍ର ଥମ ମେକାନି କାଲ ଡି ଭାଇସ ଭାବରେ
ବି ବେଚନା କରାଯାଏ । ଆବାକସ ମୂ ଳତଃ କେଉଁ  ପ୍ରା ଥମି କ ଗାଣି ତି କ କାର୍ଯ୍ୟ  କରି ବା ପାଇଁ
ଡି ଜାଇନ କରାଯାଇଥି ଲା?

A.  ଲଗାରି ଦମି କ କାଲକୁ ଲେସନସ

B.  କମ୍ପ୍ଲେକ୍ସ ସ୍କୋୟାର ରୁ ଟ କାଲକୁ ଲେସନସ

C.  ସରଳ ଯୋଗ ଏବଂ ବି ୟୋଗ

D.  ଡି ଫରେନ୍ସି  ଆଲ ଇକ୍ୱେସନସ

✓

Q83 Computer
Which of the following can seamlessly serve as both an input and
output tool, enhancing your technology experience?

A.  Mouse

B.  Touchscreen

C.  Microphone

D.  Scanner

✓

Q84 Computer
Which of the following is NOT an output device?

A.  Monitor

B.  Touch screen

C.  Keyboard

D.  Printer

✓

Q85 Computer
ମାଇକ୍ରୋ ସଫ୍ଟ  ୱାର୍ଡ ରେ, କେଉଁ  କମାଣ୍ଡ ୟୁ ଜରଙ୍କୁ  ଏକ ସି ଲେକ୍ଟ ହୋଇଥି ବା ଟେକ୍ସଟ ବ୍ଲ କକୁ
ଡୁ ପ୍ଳି କେଟ କରି ବା ଏବଂ ସମାନ ଡକ୍ୟୁ ମେଣ୍ଟ କି ମ୍ବା ଅନ୍ୟ ଏକ ଡକ୍ୟୁ ମେଣ୍ଟ ମଧ୍ୟରେ ଏକ ଭି ନ୍ନ
ସ୍ଥାନରେ କପି  ରଖି ବା ପାଇଁ  ଅନୁ ମତି  ଦି ଏ?

A.  କଟ

B.  ପେଷ୍ଟ ସ୍ପେଶି ଆଲ

C.  କପି  ଆଣ୍ଡ ପେଷ୍ଟ

D.  ଡ୍ରା ଗ ଆଣ୍ଡ ଡ୍ର ପ

✓

Q86 Computer
Where can you find the dialog box launcher for Styles in Word?

A.  On the Insert tab

B.  In the Paragraph group

C.  In the Styles group on the Home tab

D.  On the File tab

✓

Q87 Computer
What formula is used to apply the custom date format 'mm/dd/yy'
to the value in cell B2?

A.  =DATE(B2,"mm/dd/yy")

B.  =FORMAT(B2,"mm/dd/yy")

C.  =TEXT(B2,"mm/dd/yy")

D.  =CONVERT(B2,"mm/dd/yy")

✓

Q88 Computer
MS ଏକ୍ସେଲରେ 'Formula Bar' ର ପ୍ରା ଥମି କ ଉଦ୍ଦେଶ୍ୟ କ'ଣ?

A.  ଏକ ସେଲରେ ଥି ବା କଣ୍ଟେଣ୍ଟକୁ  ଡି ସପ୍ଲେ  ଏବଂ ଏଡି ଟ କରି ବା

B.  ଚାର୍ଟ  ଏବଂ ଇମେଜଗୁ ଡି କୁ  ଇନସର୍ଟ  କରି ବା

C.  ସେଲଗୁ ଡ଼ି କର ବ୍ୟାକଗ୍ରା ଉଣ୍ଡ କଲର ପରି ବର୍ତ୍ତ ନ କରି ବା

D.  ୱାର୍କ ସି ଟଗୁ ଡି କ ମଧ୍ୟରେ ନେଭି ଗେଟ କରି ବା
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✓

Q89 Computer
What is the full form of 'WAN' in networking?

A.  Wide Area Network

B.  Wireless Area Network

C.  World Area Network

D.  Working Area Network

✓

Q90 Computer
What happens when you click 'File > Print' in Microsoft Word?

A.  The document prints immediately

B.  A print preview appears on the left

C.  You can configure settings and preview the document before
printing

D.  The document closes

Reasoning

✓

Q91 Reasoning
In a certain code language,
'A + B' means ‘A is the wife of B’,
'A – B' means ‘A is the brother of B’,
'A x B' means ‘A is the mother of B’,
'A = B' means ‘A is the father of B’.

How is P related to Q if ‘P = R x Y + S – Q’?1948

A.  Father's father

B.  Wife's father's mother's brother

C.  Wife's mother's father

D.  ​Brother's wife's mother's father

✓

Q92 Reasoning
Eight employees A, B, C, D, E, F, G and H are sitting around a circular
table facing the centre. C is sitting second to the right of G. G is
sitting third to the right of E. B is sitting second to the left of D who
is sitting to the immediate right of G. F is not an immediate
neighbour of E. A is sitting to the immediate right of F.

How many people are sitting between F and G when counted from
the left of F?2293

A.  One

B.  Two

C.  Three

D.  Four

✓

Q93 Reasoning
In a certain code language, ‘BASK’ is coded as ‘7542’ and ‘SIDE’ is
coded as ‘1367’.
What is the code for ‘S’ in the given code language?

A.  7

B.  1

C.  4

D.  3

✓

Q94 Reasoning
ସାତଟି  ବାକ୍ସ F, G, H, I, U, V ଓ W କୁ  ଗୋଟି ଏ ଉପରେ ଅନ୍ୟଟି  ରଖାଯାଇଛି  କି ନ୍ତୁ ସମାନ
କ୍ର ମରେ ରଖି ବା ଜରୁ ରୀ ନୁ ହେଁ  । G ତଳେ କେବଳ ତି ନୋଟି  ବାକ୍ସ ରଖାଯାଇଛି  । G ଓ U
ମଧ୍ୟରେ କେବଳ ଦୁ ଇଟି  ବାକ୍ସ ରଖାଯାଇଛି , I ଉପରେ କେବଳ F କୁ  ରଖାଯାଇଛି  । H ତଳେ
ଏବଂ W ଉପରେ କୌଣସି  ସ୍ଥାନରେ V କୁ  ରଖାଯାଇଛି  । ନି ମ୍ନ ରୁ  ଦ୍ୱି ତୀୟ ସ୍ଥାନରେ କେଉଁ
ବାକ୍ସକୁ  ରଖାଯାଇଛି ?

A.  F

B.  H

C.  I

D.  W
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✓

Q95 Reasoning
SATE is related to BJCN in a certain way based on the English
alphabetical order. In the same way, CKDO is related to LTMX. To
which of the following options is DLEP related to, following the same
logic?

A.  MUNY

B.  MNUI

C.  MUYT

D.  NJHL

✓

Q96 Reasoning
What should come in place of ? in the given series based on the
English alphabetical order to make it logically complete?

LAD NEH PIL RMP ?

A.  SQU

B.  UPT

C.  TQT

D.  URS

✓

Q97 Reasoning
What will come in the place of the question mark (?) in the following
equation, if ‘+’ and ‘–’ are interchanged and ‘×’ and ‘÷’ are
interchanged?

55 ÷ 2 + 25 × 5 – 10 = ?

A.  113

B.  127

C.  135

D.  115

✓

Q98 Reasoning
ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମ ଆଧାରରେ ନି ମ୍ନ ଲି ଖି ତ ଚାରୋଟି  ଅକ୍ଷର-ପୁ ଞ୍ଜ ଯୋଡ଼ି  ମଧ୍ୟରୁ
ତି ନୋଟି  ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ ଉପାୟରେ ସଦୃ ଶ ଅଟନ୍ତି  ତେଣୁ  ଏହି ପରି  ଏକ ଗୋଷ୍ଠୀ ଗଠନ କରନ୍ତି
। କେଉଁ  ଅକ୍ଷର-ପୁ ଞ୍ଜ ଯୋଡ଼ି ଟି  ସେହି  ଗୋଷ୍ଠୀର ଅନ୍ତର୍ଭୁ କ୍ତ ନୁ ହେଁ ? (ଦ୍ର ଷ୍ଟବ୍ୟ: ଅସାମଞ୍ଜସ୍ୟଟି
ବ୍ୟଞ୍ଜନବର୍ଣ୍ଣ /ସ୍ୱରବର୍ଣ୍ଣ  ସଂଖ୍ୟା କି ମ୍ବା ଅକ୍ଷର ପୁ ଞ୍ଜରେ ସେମାନଙ୍କର ସ୍ଥି ତି  ଉପରେ ଆଧାରି ତ
ନୁ ହେଁ )

A.  GI-LN

B.  DF-HJ

C.  KM-OQ

D.  MO-QS

✓

Q99 Reasoning
ଶବ୍ଦ QUALITY ର ପ୍ର ତ୍ୟେକ ସ୍ୱରବର୍ଣ୍ଣ କୁ  ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମରେ ଏହାର ଠି କ
ପରବର୍ତ୍ତୀ  ଅକ୍ଷରରେ ପରି ବର୍ତ୍ତ ନ କରାଯାଏ ଏବଂ ପ୍ର ତ୍ୟେକ ବ୍ୟଞ୍ଜନ ବର୍ଣ୍ଣ କୁ  ଇଂରାଜୀ
ବର୍ଣ୍ଣ ମାଳା କ୍ର ମରେ ଏହାର ଠି କ ପୂ ର୍ବ ବର୍ତ୍ତୀ  ଅକ୍ଷରରେ ପରି ବର୍ତ୍ତ ନ କରାଯାଏ । ଏହି ପରି  ଗଠି ତ
ନୂ ତନ ଅକ୍ଷର ଗୋଷ୍ଠୀରେ ନି ମ୍ନ ଲି ଖି ତ ଅକ୍ଷରଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  କେଉଁ ଟି  ବାମରୁ  ଦ୍ୱି ତୀୟ ହେବ?

A.  V

B.  W

C.  T

D.  P

✓

Q100 Reasoning
Read the given statements and conclusions carefully. Assuming that
the information given in the statements is true, even if it appears to
be at variance with commonly known facts, decide which of the
given conclusions logically follow(s) from the statements.

Statements: All Volcanoes are Tsunamis. All Tsunamis are
Earthquakes.
Conclusion I: All Earthquakes are Volcanoes
Conclusion II: Some Earthquakes are Volcanoes3280

A.  Only conclusion (I) is true

B.  Only conclusion (II) is true

C.  Neither conclusion (I) nor (II) is true

D.  Both conclusions (I) and (II) are true
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